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We hope you enjoy this edition of Sixteen Bits. We are always on the lookout for
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15th of each month. All submissions gratefully received. Please send us
feedback as to what you might like to see published in your magazine.

For more news of events to come - don't forget to check the PCUG Calendar
at:  http://www.pcug.org.au/members/calendar/
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Main Monthly Meeting

PC USERS GROUP (ACT)

 June 2006 MONTHLY MEETING

The next Main Monthly Meeting will be held on Tuesday 6th June 2006 commencing at 
7:30 pm in the Manning Clark Centre, (facility 26A), Lecture Theatre 3, Australian 
National University, Acton. Visit the PCUG website
http://www.pcug.org.au/activities/mmm.htm for a map of the Manning Clark Centre. 

The speaker will be Matthew Smith from IBM presenting VOIP (Voice Over IP) and 
Fileserver.

The monthly meetings are free. Members, friends and the public are invited to attend. Don’t
rush home after the meeting! Stay for coffee, tea, biscuits and good company. It’s all free!
Renew acquaintances, meet new people and ask those questions you didn’t get a chance
to ask at the meeting! Membership inquiries and renewals are welcomed too! 

Email inquiries to pcug.mmm@pcug.org.au or phone 02-6287-2922.
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Report from the President

The good news this month is that by the time you read this, our
new equipment for the training room should have been delivered
and is being made operational.  We have twelve new computers
each having 1 gigabyte of memory, 160 gigabytes of disk space,
and powered by AMD 64 3000 chips.  They will be configured as
multiboot systems running Windows XP Professional and at least
one version of Linux.  This should enable our Training Manager,
David Gill, to schedule some interesting training courses.

The bad news is that the PCUG web site was hacked and the
home page replaced by outside intruders.  The majority of the site
was back within an hour or so, but we had to disable all PHP

scripts on the server until we could upgrade our security on these.  This has been done, but as a
result some existing scripts may not run on the new configuration.  If you encounter this with any
PCUG scripts, please let the admins know (admin at tip.net.au). If it occurs with any of your scripts,
please either upgrade to a current version, or rewrite using current, secure, PHP coding standards.
Thanks to Lawrie Brown and other admins who assisted in getting the system working again.

Finally, the TIP connection to the Internet was upgraded at the end of April.  Hopefully, all TIP users
are experiencing slightly better Internet performance as a result.

Allan Mikkelsen

INDEX      NEXT



From the editor's desk
Much is happening in the training world, thanks to the drive
of David Gill and the support he enlists. I try to stay out of
areas where I would be more hindrance than help, so I
haven't actually seen activity in progress in the centre this
month - only its outcome. And I know that Rod Peters, John
Saxon and Allan Mikkelsen deserve honourable mention.

Our relationship with software providers is becoming
profitable for the group. The enthusiasm shown for
Acoustica's Spin It Again last month was a classic example. 

This month we have a 20% discount on zsCompare from Zizasoft, who have also donated a packaged
copy of the software as our door prize for June. Check it out in our Press Release for zsCompare.
Beyond that, the producers of Spin It Again were so impressed as to offer all club members a free 
copy of Acoustica Photos Forever as appreciation of our support. Check it out in our Press Release for
Photos Forever.

With winter approacing I will be heading north for my regular three months hibernation in sleepy
Queensland, where the lifestyle is vastly different from here. Trevor Frew, who taught me pretty well all
I know about the trade, will be back in control of Sixteen Bits. I will try to contribute where I can
because it's a lot of hard work putting the magazine together without contributors.

Finally, I would like to remind everyone who attends our Coffee & Chat group meetings in the Irish
Club in the south and Wests in the north that we gain more benefit from the relationship than we
provide. Our meeting rooms are provided free of charge, in a commercial atmosphere where other
groups are paying for the privilege. And for this we sometimes have to settle for less-suitable rooms
than we would like. Although they almost invariably do, there is no obligation on the part of the clubs to
set up the rooms in our configuration, nor to ensure that markers for the whiteboards are both
available and fresh. Let us appreciate and be thankful for service courteously provided, and respond
accordingly.

Terry Bibo
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PCUG Meetings 2006

The Main Monthly Meeting will be held on the first Tuesday night each month during 2006. The
planned dates are:

  6 June 2006
 4 July 2006  1 August 2006
 5 September 2006  3 October 2006
 7 November 2006  5 December 2006

The meetings will commence at 7:30 pm, and are normally held in Lecture Theatre 3, Manning Clark
Centre, Australian National University, Acton. 
The monthly meetings are free. Members, friends, and the public are welcome to attend. Stay for
coffee, tea, biscuits and good company after the meeting!

E-mail inquiries to mailto:pcug.mmm@pcug.org.au or phone 02-6287-2922
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Training News
'Excel Basics and Advanced Q and A'

An Excel workshop will be held between 10.30 - 12.30 on Saturday, 20th May. 

For full details check our training calendar at http://www.pcug.org.au/training/

The full content of the PC Security workshop held on 29th April is included in this month's magazine. If
there is a demand for it, it can be incorporated into the training material that will become progressively
available through our home page and independent of the magazine.

The past month has seen a lot of basic preparation and behind the scenes work in the training room.
By the time we go to press there should be 12 new computers and an overhead data projector
operating there.
380 MB of Microsoft Unlimited Potential training resources have been mounted at 
http://www.pcug.org.au/training/trainingcds.htm for download for any trainers to have a go at putting 
on a workshop.

What we need now, of course, are more members prepared to give their time and talents into utilising
these resources and helping David Gill in his considerable efforts in structuring our training
procedures.

INDEX        NEXT
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Basic PC security
Freeware
Firewalls       

A firewall in our case is a piece of software that filters the information coming through the 
Internet connection into our PC. If  incoming information is flagged by the filters, it is not
allowed through. Most firewalls also prevent unauthorised data from leaving the PC and
spreading viruses and Trojans that have infected them.

            Windows Firewall
 Level of protection   Windows Firewall helps block computer viruses and worms from 
reaching your computer. It does not monitor or block outbound traffic. It does prevent
unauthorized traffic from entering the system or network, but Microsoft has argued that
software companies should be responsible for outbound traffic. For the majority of users
who don't understand computer security or how firewalls work, the Windows Firewall is
acceptable.  Briefly, it is a  stateful  firewall that keeps a table of all the communications
that have originated from the computer running the firewall. Only packets matching a
known connection state will be allowed by the firewall; others will be rejected. It compares
all inbound traffic from the Internet to the entries in the table. When someone on the
Internet or a network tries to connect to your computer, Windows Firewall blocks the
connection. Inbound Internet traffic is permitted to reach your computer only if there is a
matching entry in the table that shows that the communication exchange began in your
computer.

Activation    By default, Windows Firewall is turned on. To configure Windows Firewall, 
use Security Center in Control Panel, or open the firewall itself from Control Panel.

In its simplest and most used form Windows Firewall needs no further attention.

It is not recommended to run Windows Firewall in conjunction with any other firewall

Advanced users should read more at http://support.microsoft.com/kb/843090#EHADAAA

            Zone Alarm                   
 Installation        Download and run the executable file from ZoneLabs

Level of protection    ZoneAlarm Free provides port blocking against hackers and other 
unknown threats and runs in Stealth Mode to make your PC invisible on the Internet. If you 
can`t be seen, you can`t be attacked.  It keeps personal data private and secure, deletes
adware cookies, blocks pop-up ads, and provides limited e-mail protection in the free
version by monitoring attachments for vulnerable file extensions..

                
                    Features    There are six main headings for features: click here to see screen shots.
                                          Overview    Firewall    Program Control    Anti-virus monitoring    E-mail 
protection     Alerts & Logs

A feature not provided by other firewalls is Internet lock. By right clicking on the ZoneAlarm
icon in the system tray you can click on Engage Internet Lock which displays a yellow lock
icon in the system tray. All Internet traffic initiated by programs without pass-lock
permission is blocked. Or you can Stop all Internet activity, which displays a red lock icon
in the system tray.To reverse this action simply right click on the lock icon and untick the
feature.

http://support.microsoft.com/kb/843090#EHADAAA


                   
There is an excellent online tutorial available from:      
http://download.zonelabs.com/bin/media/flash/clientTutorial/overview.html

This is a large file and probably not suitable for dialup connections.

                    Updating    Automatic or Manual - set in Overview> Preferences 

AntiVirus

            Avast
 Installation    Download and install the free avast! 4 Home Edition from
http://www.avast.com/eng/download-avast-home.htm

Registration    Registration is free for 12 months (or 14 months including the initial 2
months when it can be run unregistered), and there are many paths to the one source.
Click here for one recommended way.

Options    As with any software as complex as this there are countless options on how you
set it up. Most users would be wise to leave the default settings, and not change anything
they are not familiar with through reading the help file and are prepared to accept the
consequences. The Program Settings are accessible by right clicking the system icon.

 Protection    The prime function of Avast is provision for virus detection and removal,
scanning of incoming and outgoing mail, and restoration of corrupted files using a compiled
Virus Recovery Database. In the free version we have a Simple User Interface that is
intended for users who do not need to configure the program in detail, but just want to use
the program as is. All the necessary functions can be easily accessed: virus scanning,
accessing the Virus Chest, virus database updates, setting the level of resident protection.
Resident protection is a special type of task that monitors all applications being executed
and all documents being opened, effectively avoiding virus infection in real time. The task
contains a number of so-called providers that are special modules protecting various parts
of your computer, e.g. file system or e-mail. Each of these modules can be set up
independently.

Avast is able to show some basic information about the viruses in its database. For
widespread viruses, quite comprehensive information can be obtained via the avast!
connection to our web virus database. 
To browse and search for information about viruses go to Menu - Virus database in Simple 
User Interface. 

To keep the Avast users informed, the latest news is distributed in the same way as
program updates; it informs users about new virus risks, important changes or
improvements of the program etc. In the Simple User Interface click on the Menu button 
and select avast! iNews.

                    Updating    I recommend you set the update options to Automatic as shown in the
Program Settings image.

For broadband users whose PCs are always online the software will update its database 
and program files as often as necessary. 
For users who choose to log on, the software will update its database immediately on
connection to the Net and as often as necessary while connected. Updating is done in the
background and announced by voice and popup message on completion. Program
updates are announced by popup as being available, and will proceed in the background
as soon as authorised.  
Nearing the end of the registration period the user will be notified by popup that

http://download.zonelabs.com/bin/media/flash/clientTutorial/overview.html
http://www.avast.com/eng/download-avast-home.htm


reregistration is necessary. It is not necessary to download and reinstall the software!
Simply walk through the registration process and get a new license key. 
If you do not reregister the software will continue to work at the level of last update, but no
new updates can be installed either automatically or manually.
Manual updating can be forced at any time during the registered period by choosing the
Updating option available on right clicking the system icon.

Spyware & Malicious Software

Spyware is simply software that gathers personal information from your computer,
generally for sale to companies creating demographic statistics. It is installed without your
permission and almost always without your knowledge. A variation on spyware is adware,
which tracks the content and advertisements you click on in your browser.This can be used
to deliver targeted adverts to you in the form of popups. Tracking cookies are ubiquitous
throughout the Internet and can notify companies about every site you visit that contains
their ads.

            Spybot S&D
Installation     The latest version of Spybot S&D is always available from The home of 
Spybot. It is commonly available on the CDs with computer magazines but is often a
version behind the current one after an update. Download and install the executable file.

                    
Features    Spybot - Search & Destroy can detect and remove spyware of different kinds
from your computer that common anti-virus applications do not yet cover. These include
toolbars in your Internet Explorer that you didn't intentionally install, and changes to your
start page that you did not authorize. But there is increasingly more spyware that is silently
tracking your surfing behaviour to create a marketing profile of you for sale to
advertisement companies. This has its good points, but many people see it as an
infringement of their privacy. Spybot-S&D can also clean usage tracks, removing any trace
of what documents what you worked on and preventing other users from spying on your
activities. And for advanced users it allows fixing some registry inconsistencies that are not
covered by the conventional registry repair utilities. Click here for the tutorial.

            Spyware Blaster
                    Installation    Download and install the latest version from:
                    http://www.javacoolsoftware.com/spywareblaster.html

Tools and features    SpywareBlaster has been developed to reduce or greatly eliminate
spyware-related problems such as diallers, browser hijackers, and adware. Its primary
function is to block spyware before it gets into the computer, and in this it works in close
cooperation with Spybot S&D. It protects Mozilla Firefox as well as Internet Explorer, and
has tools addressing specific areas of vulnerability. Like WindowsXP SpywareBlaster can
create restore points for its system state. 

Its three areas of interest are: Protection  System Snapshot  and  Tools.

Without getting too technical, SpywareBlaster blocks spyware by identifying its unique
class identifier - (CLSID) and preventing it entering your PC. CLSID values are applied to
all elements of a web page being opened by your Internet Explorer browser, and are
specifically applicable to ActiveX. It appears that most malware attacks depend on ActiveX
for their activation and propagation to other computers.

                    Set & forget    SpywareBlaster does not need to remain open for its protection to be
active! 

Simply Check for Updates feature at least once a week to download the latest protection. 

http://www.javacoolsoftware.com/spywareblaster.html


            Windows Malicious Software Removal Tool
                    Installation - automatic on 2nd Tuesday every month as part of Microsoft Windows
Update.

                    Activation -
                            self activates
                            runs and cleans
                            removes itself                     

Resources

            Process Library  &  Quick Access toolbar 
Process Library is a free Internet site that provides an extensive library of Windows
processes and applications, with definitions describing their various forms. Many of them
have been hijacked by Trojans and are not immediately identifiable as such. Click here to 
see screen shots.

            Start-Up Applications
Paul Collins, who provides the database used in Spybot S&D maintains a searchable, 
comprehensive list of the programs you may find that run when you switch on your PC. It is
not a list of tasks/processes taken from Task Manager and shown by
pressing CTRL+ALT+DEL, but is a list of startup applications that is updated regularly,
available at: http://www.sysinfo.org/startuplist.php?

A printable version in ZIP format is available from:
http://www.pacs-portal.co.uk/startup_pages/startups_all.zip

            

Enjoy your computing

Terry Bibo

 NOTE: This presentation is not reproduced in full in PDF format in this magazine, therefore links from
this page will not work.
To view the entire presentation off line you must download the ZIP file.
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Registry Booster
Registry cleaners have been around for a long time now, and some of us can remember when we
used Microsoft's RegClean on Win95 and Win98. That is still available on some websites but even
then it had a very limited function. It did not fix a corrupt registry and was limited to fixing problems
with normal Windows Registry entries located in HKEY_CLASSES_ROOT. Besides that it had severe
incompatibilities with Win XP. RegClean is now no longer supported and has been removed from all
Microsoft download sites. But there are almost countless others.
Registry Booster has recently been released by Uniblue Systems Limited and is a serious contender
in the market. In committing to write this review I disclosed that I have been using Jv16 Power Tools
for some years as my registry cleaner. I am sure Uniblue will accept my drawing comparisons with this
utility and one other, RegCleaner, which is a subset of Jv16 Power Tools and is free. The first
comparison must be that Jv16 Power Tools is a multi-purpose utility that I have found invaluable for
functions other than cleaning the registry, whereas Registry Booster is dedicated to that one task only.
Jv16 Power Tools should probably be considered as a power-user utility. It requires learning and
understanding that many PC users are not prepared to devote. And rightly so, most users don't want
to delve into the bowels of their operating system. Registry Booster is very safe and very easy to use.

What is the Windows registry? 

The registry is a large database that is used by Windows for general settings and preferences,
storage of hardware and software configurations, and hardware drivers and devices. Whenever you
make any changes in your preferences or settings, installed software or hardware, these changes are
stored in the Windows registry. 
Keeping your registry in a good state of repair and conducting regular maintenance is imperative,
because the registry contains important data that is used all the time during system operation. When
you install, uninstall, and reinstall programs on your computer, registry keys are created, modified, or
deleted. Many of these entries are not removed when they are no longer needed and the registry
grows and becomes more complex. The registry also becomes fragmented, like a hard disk, creating
gaps and wasted space that may lead to problems. 

What do regcleaners clean?

To some degree all regcleaners scan for errors in your registry and effect repairs. Each utility has its
own preferences but many obviously overlap. Registry Booster has an extensive list including, but not
restricted to:

Registry integrity and shell folder entries. 
Software locations including missing, orphaned, broken or bad application paths.
Unwanted browser objects.
Corrupt Active X/COM Objects.
Redundant Startup applications and uninstalled application schedulers.
Obsolete shared DLLs and folders.
Uninstalled software remnants.
Unused and unwanted drivers.
File extensions and associations.
Unnecessary fonts and recent files list.



Commensurate with all Uniblue products the layout is clear and the information is obvious. 
The help file, which I recommend you all to read, is complete and easily followed.

This is the Navigation panel before any activity has been carried out.

Configuration Settings refers to various startup options and creating backups before repairing - the
same information that is available by selecting the Settings tab. 

Defrag Registry can take a few minutes and requires a system restart to take effect, as is the norm
with a Windows System Restore and some program updates that need to read in the new registry.

Start Scan opens the dialog below.

Here we get a better 
appreciation of just what 
is scanned for correction
in the registry, and this is 
in the very early stage of
scanning.

There were 338 errors 
found in this scan, 
which was the first I had
done on this PC. We 
should expect to see 
150 or more on the 
average PC's first scan. 

By comparison Jv16 



Power Tools found only 
6 errors. 
But its free subset, 
RegCleaner, found 17.

These scans were all 
done on the same 
registry in turn. I did not 
repair the registry until 
after doing the 
comparisons. 

The question arises, therefore, of what is the definition of an Error or a Problem. Overwhelmingly the
majority of my problems were Missing or Invalid Path, which I show as one of three common problems
on this PC. 
To see if this could really be a problem I Googled it, and quote from the answer to a user's problem.
"If any of these keys point to an invalid path, the installation will fail to properly install.These registry
entries need to be fixed in order for the installation to complete successfully." 
Very recently I had a serious problem with a Firefox display. It grew an broad grey bar along the
bottom edge that I could not remove by changing options and removing extension add-ins.
Uninstalling and reinstalling Firefox twice only increased the size of this bar to two, then three times its
original size. Only when I manually removed all Firefox entries from the registry did the problem go
away on the next installation. At that time I was not running Registry Booster, but I now wonder if that
might have detected and solved the problem. 

When changes are made to the registry it is always advisable to make a backup first, and clicking on 
Repair Registry  will bring up a dialog box offering this choice before proceeding if you have not
already created a backup. Remember, if you do not create a backup you cannot return to that
configuration.
I know there are those who say the registry needs no maintenance, but I prefer to err on the side of
safety. I credit my years of regularly cleaning the registry with having as much input into my PC peace
of mind as does my antispyware running continuously in the background. 

For users who want
more control than that 
provided by the 
default settings, the
Registry Scan tab 
allows any section 
within the scan to be
unticked, whereas the 
Start Scan button on 
the Navigation panel 
immediately starts the 
scan on the current 
settings.

If you intend to do a
partial rather than a 
full scan you should 
read the details of
each of these items in 
the comprehensive 

help directory. 
Details are succinct but informative, and are an excellent tutorial for gaining a good background
knowledge and understanding of the registry and its functions.



Registry Booster creates an undo file whenever it 
makes any changes to the registry.
If you are not satisfied with the changes made, you
can select from a list of backup files shown on the 
Restore tab on the Navigation panel. Click on the
Restore button and your system will be taken back to
that previous configuration.

Be aware that restoring an old configuration will
restore all errors within that configuration and, if you

have affected changes in your registry after the file was backed up, the restore function may undo
these changes.

Backup files are limited to a maximum of five, so older files should be selected and then removed by
clicking on the Delete button.
(Obviously my too-frequent backups are made in the course of writing this review, not out of 
necessity.Ed)

While I do not see defraging the registry as important as repairing it, it is something I do regularly as
part of PC housekeeping. A normal figure would see a recovery of 3% of space, but I have had up to
9%. 
I would recommend that you run the Defrag Registry function of Registry Booster as a normal routine.
Every little help we can give our operating system in working more efficiently is worthwhile.

Registry Booster is available for download from http://www.liutilities.com/products/registrybooster/ 

Enjoy your computing.

Terry Bibo
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Press Releases

zsCompare

Synchronise computers, backup data, compare file versions.

Photos Forever

Finds your photos, tells you how many CDs or DVDs you'll need, proceeds to burn them, prints
out a convenient 'key' list.
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zsCompare
synchronize computers, backup data, compare different versions of files

I'm pleased to inform you and the members of ACT PC Users Group that Zizasoft has released
zsCompare version 3.0.  ZsCompare allows you to synchronize computers, backup data, compare
different versions of files, verify that CDs have been copied correctly, manage Zip files, review
changes to source code, and more. Users can easily run comparisons on local directories or across
networked computers. Comparisons can also be performed on removable media such as CDs, DVDs,
and flash drives. 
 
ZsCompare 3.0 includes several new enhancements and is available in three editions to satisfy a
broad range of user needs.

We would also be pleased to offer you one copy of zsCompare Lite Edition to be used as a door prize
at one of your meetings. Finally, we would like to offer your members a 20% discount on all editions of
zsCompare.  To take advantage of the 20% discount, your members should enter the coupon code
"ACT PC Users Group" when they purchase a license at https://www.zizasoft.com/store/order.shtml. 
 
Best Regards,
 
Mark D. Noble
President, Zizasoft LLC.
mnoble@zizasoft.com
www.zizasoft.com
________________________________

ZsCompare allows users to efficiently synchronize computers, backup data, compare different
versions of files, verify that CDs have been copied correctly, manage Zip files, review changes to
source code, and more. Users can easily run comparisons on local directories, networked computers,
or removable media, such as CDs, DVDs, and flash drives. zsCompare is highly customizable to meet
a wide range of needs.

ZsCompare 3.0 adds many new file and freeform text comparison features, including the ability to
compare text from Microsoft Word documents and PDF documents. Also, zsCompare provides
additional control over how the comparison is performed with predefined options for common
comparisons.  Finally, the new version of zsCompare permits direct editing of the contents of a file
from the results.

New directory comparison features in zsCompare allow users to create and compare Snapshots of the
file system and to create and apply Patch files for files and directories. Patch files allow users to store
just the differences between two files or directories. This saves space on hard drives and allows users
to easily send small files to people at remote locations. Users can also directly modify file names,
attributes, and timestamps from the results now.

Also new is the ability to save sets of options for future use. Users can easily change between sets of
options from the main comparison screen. Having multiple options sets provides quick access to
different types of comparisons and allows users to obtain the best results depending on what is being
compared.  

ZsCompare 3.0 operates on Windows, Mac OS X, and Linux. It runs on the Java platform, a copy of
which is included with the zsCompare installation.

ZsCompare 3.0 is available in three editions: Professional ($199.95), Standard ($99.95), and Lite 
($35.00). 

https://www.zizasoft.com/store/order.shtml
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The Lite Edition contains basic comparison and synchronization functionality. With the Lite Edition,
users can compare directories, zip files, text files, and freeform text.

The Standard Edition contains all of the features in the Lite Edition plus it adds several additional
features to increase productivity. The Standard Edition includes support for creating and comparing
snapshots as well as support for changing attributes, timestamps, and file names directly from the
results. The Standard Edition also has more powerful text comparison options, and the ability to
directly edit the text of a file from the results.  With the Standard Edition, users can also view results in
a binary mode to compare non-textual files.

The Professional Edition contains all of the features in the Standard Edition plus support for
comparing the text of Microsoft Word documents and PDF files. The Professional Edition also lets
users create and run scripts to automate the complete functionality of zsCompare.

All versions include free lifetime upgrades and free technical support. 

More information, including a complete list of enhancements and a fully functional 30 day trial version,
is available at http://www.zizasoft.com/products/zsCompare/index.shtml.

http://www.zizasoft.com/products/zsCompare/index.shtml


Hi Terry,

Thank you again for your support of Acoustica Software. We would like to offer your club
members a free copy of Acoustica Photos Forever as appreciation of your support.

Photos Forever, it's boiled down to a few clicks. It finds your photos, where ever they might be. It tells
you how many CDs or DVDs you'll need and then proceeds to burn them! After each disc is done, a
sound chimes to let you know it's ready for the next one! After the discs are created, it'll even print out
a convenient 'key' list so that you can reference what picture is on which CD!!

*Don't Take Our Word for it...*

Wow!!!!!!! That's all I can Say. How easy was that? I backed up1432 pictures to a CD in less that
10 minutes from start to finish. This program is no fuss, no muss. Straight forward, Nothing fancy
& not a ton of options. Designed to do one thing and it does it well. I sure feel better having those
1432 pictures on a CD backup.  

I have never been able to copy photos to disk so fast and effortlessly! Even easier than using
explorer! Much easier than XP's version of "new and improved". Keep up the good work,
Acoustica! Your products haven't failed me yet! 

Please supply me with email addresses of people who are interested in receiving a license in your 
club.

I will email them a download link and registration code of Photos Forever.

BTW I will not put them in our mailing unless they request to have more information on 
Acoustica Software.

David Raimondo 
Director Of Sales & Business Development Acoustica Software 
P: 559-692-2224 ext 1008 
F: 559-692-2214 
David@Acoustica.com <mailto:David@Acoustica.com> www.Acoustica.com 
<http://www.Acoustica.com> 
Acoustica - "Software should be easy to use!"

free Photos Forever - 
your email address can be added to those wishing to
get a copy of this by going to the User Services area,
https://www.tip.net.au/user  and selecting the
"Acoustica Software Offer".

mailto:David@Acoustica.com
mailto:David@Acoustica.com
http://www.Acoustica.com
http://www.Acoustica.com
https://www.tip.net.au/user


Freeware discussion

How to Enable Audible Caps Lock Warning

It's easy to hit the Caps Lock key by mistake and find yourself typing in capital letters. Worse, if you
don't know Caps Lock is on, your password may be rejected for no apparent (to you) reason. You can
use the built-in ToggleKeys feature to sound an audible warning when you hit Caps Lock, Num Lock
or Scroll Lock. Here's how: 

In Control Panel, click Accessibility Options.1.
Click the Keyboard tab.2.
Check the Use ToggleKeys checkbox.3.
Click OK.4.

Unhide the Administrator

Few people are aware of Windows XP's cloaked administrator account (called, appropriately enough,
"Administrator"). 
This account is invisible unless either your system has no other accounts or you are booting in Safe
Mode. 
To remove Administrator's camouflage and add it to XP's Welcome screen, navigate to and then
select HKEY_LOCAL_ MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Winlogon\SpecialAccounts\UserList in the Registry Editor and double-click the
Administrator icon in the right pane. (If you don't see this icon, right-click in the pane, choose New
DWORD Value, name it Administrator and press <Enter>.)
 
Type 1 in the "Value data" box and press <Enter>. From now on, when you open the User Accounts
window via the Control Panel (choose Start-Run, type Control userpasswords and press <Enter>),
you'll see the Administrator account. 
 
You can easily change its picture or give it a password. In addition, the next time you see the welcome
screen your Administrator account will be visible, along with all of the computer's other user accounts.

Baillie McK

Or.....more simply and no messing with the Registry, download and install TweakUIXP from the 
Microsoft web site and pick the option "Show Administrator on Welcome screen" from the Logon tab.

TweakUIXP also has a number of other "useful" features - depending on your point of view!!! - and far 
too many to detail here.....   (Download from the Snapfiles link here for the latest 563K 2006 version. 
The M$ download site still has a 2002 version at 147K. Ed.)

Charlie K 

 OE5 $ OE6 Backup

I am amazed so few people do this. Yes there are other ways.
 
Why is this the best? - Because it is in front of you and you can do it now!
 
Copy Mail Files to a Backup Folder

To make a backup copy of your Outlook Express e-mail message files:



On the Tools menu, click Options.1.
On the Maintenance tab, click Store Folder.2.
Select the folder location, and then press CTRL+C to copy the location.3.
Click Cancel, and then click Cancel again to close the dialog box.4.
Click Start, and then click Run.5.
In the Open box, press CTRL+V, and then click OK.6.
On the Edit menu, click Select All.7.
On the Edit menu, click Copy, and then close the window.8.
Right-click any empty space on your desktop, click New, and then click Folder.9.
Type Mail Backup for the folder name, and then press ENTER.10.
Double-click the Mail Backup folder to open it.11.
On the Edit menu, click Paste.12.
Close the Mail Backup window.13.

Importing Outlook Express data

To restore data, you may need to re-create the Identities for each user, prior to using the following
steps. Repeat each step, as needed, for each Identity.

Import Messages from the Backup Folder

To import your Outlook Express e-mail messages from the Backup folder:

On the File menu, point to Import, and then click Messages.1.
In the Select an e-mail program to import from box, click Microsoft Outlook Express 5 or 
Microsoft Outlook Express 6, and then click Next.

2.

Click Import mail from an OE5 store directory or Import mail from an OE6 store directory, and 
then click OK.

3.

Click Browse, and then click on the Mail Backup folder on your desktop.4.
Click OK, and then click Next.5.
Click All folders, click Next, and then click Finish. 6.

Baillie McK

Well if you use Outlook (as opposed to Outlook Express) then Microsoft have looked after you  :-) and
you can install a full backup add-in which works well.

I've been using it for years and it has proven very handy when reinstalling or rebuilding a system.

I have mine set to run daily, mind you, as belt and braces  - cos I regard e-mail as one of my most
critical sets of data - I do also run a backup (using the freebie EZbackitup) of the pst file which, by
default, is buried way down in the Documents and Settings folder at C:\Documents and 
Settings\User name\Local Settings\Application Data\Microsoft\Outlook\Outlook.pst (substitute 
your username for "User name")

http://www.snapfiles.com/get/ezbackitup.html

Charlie K

 TweakGuides Tweaking Companion

At the C&C meeting on Tuesday 9th May Roger L. mentioned a tweakguides site that offered excellent
material on Windows XP among its items. I was sufficiently interested to follow up on this and now
have a Deluxe version PDF file that belongs in every XP owner's library.

The author is Koroush Ghazi, and I can do no better than let him speak for himself:

http://www.snapfiles.com/get/ezbackitup.html


"The totally revised TweakGuides Tweaking Companion Version 3.0 is the complete system
optimization guide for Windows XP users. It contains an enormous amount of detailed descriptions and
resources together in one free 175 page downloadable PDF file. Everything from the correct
installation of Windows and critical software and drivers, through to recommendations for every
significant setting in XP, all the major performance, visual and convenience tweaks, and descriptions of
XP's functionality. The guide contains dozens of links to major free applications for optimizing and
maintaining your system, as well as to a vast range of resources for finding out more about your PC
and troubleshooting PC problems. Basically the TweakGuides Tweaking Companion is the mother of
all Windows XP tweak guides and system optimization guides.

The TweakGuides Tweaking Companion Deluxe Edition is a 215 page guide which can either be sent
to you in PDF format, or purchased as a professionally printed and bound book.

The TweakGuides Tweaking Companion Deluxe Edition is a more comprehensive version of the 
TweakGuides Tweaking Companion [Regular Edition]. Among its new features, the Deluxe Edition
contains full URL addresses next to each hyperlink - this makes the document easier to use in hard
copy form. The Deluxe Edition contains full screenshots and graphics throughout the guide, and all text
is higher resolution than the Regular Edition. The Deluxe Edition can either be ordered as a PDF file,
or as a professionally printed perfect-bound hard copy book with a full-color cover. The Regular and
Deluxe Editions of the guide do not differ in terms of content or advice - the Deluxe Edition is a way of
both showing your support for TweakGuides.com and at the same time gaining a unique, elegant and
comprehensive system optimization guide in return for your support."

I bought the Deluxe Edition PDF file for US$10 and count it as one of my best investments yet in 
Windows XP.

Terry Bibo

INDEX       NEXT



Digital Discussion 

DiskInternals Flash Recovery 2.0 Turns Complex Photo Recovery from
Various Storage Media into A Few-click Fun Affair

(I reviewed version 1.11 in February 2005. Available at 
http://www.pcug.org.au/~tbibo/articles/flash_recovery.htm  Ed.)

SEATTLE, WA. - April 10, 2006: DiskInternals Research, a respected innovator in digital photo
recovery technologies, today announces the release of DiskInternals Flash Recovery 2.0. This
application gives you a wizard-style user interface that lets you recover deleted or lost photos
from various storage media, including cameras, flash memory devices, hard drives, and external
drives. Now, you can recover photos and even movies you may have lost due to a hardware
malfunction, a virus attack, or simple carelessness when you or some other people have deleted
them by mistake. Version 2.0 comes with a new extra features and improvements that make the
process of photo recovery even faster and more convenient for home users.

DiskInternals Flash Recovery has been designed with the home user in mind, the one who has
no knowledge of recovery technologies. This is reflected in the user interface, which is made as
a wizard to guide you through all the stages of photo recovery in a point-and-click fashion. The
wizard restricts your efforts to selecting a storage media and a type of scan, either fast or full
drive. The scan and recovery are fully automated, so there is even no need to attend to the
process. However if you stay at your computer, you will be rewarded by a slideshow. As soon as
the first recoverable images have been found, DiskInternals generates their thumbnails and,
instead of a dull progress bar, you will see an animated slideshow of the search results.

With the DiskInternals' software in place, you can recover almost all popular image formats. The
program is very good at restoring RAW, CR2, CRW, TIFF, and JPEG photos from formatted
memory cards. All other image formats are also supported and recoverable. Moreover, you can
use DiskInternals to recover deleted movies, which may be in the AVI, MOV, and MPEG formats.
Regardless of what you are trying to recover, the program always demonstrates excellent results.
They are due to the unique recovery technology - expanded file search. The DiskInternals'
artificial intelligence analyzes every bite of the memory card and compares it to the equivalent in
its own base. This enables you to recover photos from the memory cards that have been
damaged or formatted.

The results of the scan are displayed as thumbnails in the wizard's window. You can preview any
of them full size, be it a photo or movie, simply by double-clicking on the appropriate thumbnail.
The selected item is displayed in a separate window along with its information, including the
name, image format, and size. The Preview option is available even in the free trial version.
Another convenience comes with an ability to filter found items, which allows you to narrow your
view and see photos and movies that fall into a particular category. You can categorize items by
their type (photos, RAW photos, movies), size, or their status (lost and deleted files, or existing
files). What's more, you can specify your own file mask to categorize. All in all, DiskInternals
software makes a perfect companion for any home photo enthusiast.

Read more information at http://www.diskinternals.com/flash-recovery/product.shtml
Watch the online demo at http://www.diskinternals.com/flash-recovery/demo.shtml

Pricing and Availability
DiskInternals Flash Recovery 2.0 requires Microsoft Windows 95/98/NT/2000/XP/2003 and costs
$39.95 (USD) for a single-user license. Registered customers are entitled to free upgrades and
priority technical support. Discounts for volume buyers are available. Additional information on

http://www.pcug.org.au/~tbibo/articles/flash_recovery.htm
http://www.diskinternals.com/flash-recovery/product.shtml
http://www.diskinternals.com/flash-recovery/demo.shtml


More humour from the net

Computer history of the world
In the beginning, God created the Bit and the Byte. And from those he created the Word.

And there were two Bytes in the Word; and nothing else existed. And God separated the One from the
Zero; and he saw it was good.

And God said - Let the Data be; And so it happened. And God said - Let the Data go to their proper
places. And he created floppy disks and hard disks and compact disks.

And God said - Let the computers be, so there would be a place to put floppy disks and hard disks
and compact disks. Thus God created computers and called them hardware.

And there was no Software yet. But God created programs; small and big... And told them - Go and
multiply yourselves and fill all the Memory.

And God said - I will create the Programmer; And the Programmer will make new programs and
govern over the computers and programs and Data.

And God created the Programmer; and put him at Data Center; And God showed the Programmer the
Catalog Tree and said You can use all the volumes and subvolumes but do not use Windows.

And God said - It is not good for the programmer to be alone. He took a bone from the Programmer's
body and created a creature that would look up at the Programmer; and admire the Programmer; and
love the things the Programmer does; And God called the creature: the User. 

And the Programmer and the User were left under the naked DOS and it was Good. 

But Bill was smarter than all the other creatures of God. And Bill said to the User - Did God really tell
you not to run any programs? 

And the User answered - God told us that we can use every program and every piece of Data but told
us not to run Windows or we will die. 

And Bill said to the User - How can you talk about something you did not even try. The moment you
run Windows you will become equal to God. You will be able to create anything you like by a simple
click of your mouse. 

And the User saw that the fruits of the Windows were nicer and easier to use. And the User saw that
any knowledge was useless--since Windows could replace it. 

So the User installed the Windows on his computer; and said to the Programmer that it was good. 

And the Programmer immediately started to look for new drivers. And God asked him--What are you
looking for? And the Programmer answered--I am looking for new drivers because I can not find them
in the DOS. And God said - Who told you you need drivers? Did you run Windows? And the
Programmer said - It was Bill who told us to! 

And God said to Bill - Because of what you did, you will be hated by all the creatures. And the User
will always be unhappy with you. And you will always sell Windows. 



And God said to the User - Because of what you did, the Windows will disappoint you and eat up all
your Resources; and you will have to use lousy programs; and you will always rely on the
Programmers help. 

And God said to the Programmer - Because you listened to the User, you will never be happy. All your
programs will have errors and you will have to fix them and fix them to the end of time. 

And God threw them out of the Data Center and locked the door and secured it with a password.

Index        Next



PCUG Help Directory

The people in this directory are volunteers, so please observe the times given. The Help
Directory is designed to help individual users and should not be used as a substitute for
corporate support calls to vendors. This service is provided for members only. 
Email addresses have been altered to foil spam farmers; just replace the @ symbol.
Please quote your membership number to the helper. Additions or amendments to this
directory should be sent to
editor@pcug.org.au

Region Subject Name Email Phone Days Times
Chifley WinXP, PC

hardware, 
Connections
Home
Installation 
Team (HIT)

John
Saxon

jsaxon at 
pcug.org.au

6161 1524 All
days

9am to 
7pm

Dickson WinXP, Mozilla, 
Office XP

John 
Agnew

jfa at pcug.org.au 6249 7911
0411147321

All 
days

9am to 
9pm

Fisher MS Word, 
Excel, Lotus 
WordPro,
Agent

Derek 
Jordan

Derek.Jordan at 
tpg.com.au

6288 7810 All 
days

Any 
decent 
time

Flynn Flight 
Simulator

Roger 
Lowery

bandrlowery at 
optusnet.com.au

6258 1583 All 
days

Any 
decent 
time

Hall 
Village

Noteworthy 
Composer

Andrew 
Purdam

apurdam at 
pcug.org.au

6230 2231 All 
days

Any 
decent 
time

Hawker Home 
Installation 
Team (HIT)
Internet
connections, 
software and 
hardware.

Gordon 
Urquhart

gordonu at 
pcug.org.au

6254 5480 All 
days

Any 
decent 
time

Holt FrontPage, 
Publisher,
Internet
Explorer

Gary 
Potts

gjpotts at 
pcug.org.au

6254 2818
0402342818

Mon
Wed
Sat

9:00am 
to
12:00
noon

Macquarie Linux Rod 
Peters

rpeters at 
pcug.org.au

6251 2580 All 
days

9am to 
7pm

O'Connor Digital 
Photography, Paint 
Shop Pro, Paint 
Shop Album

Jeff
Colwell

jeffmeg at 
webone.com.au

6247 7756 All 
days

9am to 
8pm
      

Page Free software
- installation

Terry 
Bibo

tbibo at 
pcug.org.au 6255 2168 All 

days
9am to 
7pm

mailto:editor@pcug.org.au


and advice

PCUG Contacts

PCUG pcug at pcug.org.au

President president at pcug.org.au

Secretary secretary at pcug.org.au

Treasurer treasurer at pcug.org.au

Executive executive at pcug.org.au

Committee committee at pcug.org.au

Office Manager office.manager at 
pcug.org.au

Magazine Editor editor at pcug.org.au

Web site Feedback serfweb at pcug.org.au

Membership membership at pcug.org.au

Main Monthly Meeting mmm at pcug.org.au

Special Interest Groups sigs at pcug.org.au

Volunteers Coordinator volunteer at pcug.org.au

Training Coordinator training at pcug.org.au

Some handy links

Committee
Members

http://www.pcug.org.au/members/committee/index.htm

Monthly
Calendar

http://www.pcug.org.au/members/calendar/

Special 
Interest 
Groups

http://www.pcug.org.au/activities/sigs.htm

Members'
Services & 
Charges

http://www.pcug.org.au/member_info/services.htm

Bookings 
for 
Training 
Courses

training at pcug.org.au
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